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Sea Surface Temperature Trends of the 
Gulf Stream 

Adapted from:   My NASA Data Lesson Plans 
http://mynasadata.larc.nasa.gov/preview_lesson_nostds.php?&passid=13 

 

Focus on Inquiry 
Students focus on inquiry by collecting and analyzing sea surface temperature data within a specific year, looking for 
patterns in the data, and constructing and using graphs to analyze the data. 
 

Lesson Overview 
Students use the internet to collect data on Gulf Stream sea surface temperature from satellites to explore weather and 
climate changes and to explore how the Gulf Stream affects seasonal changes.  
 

Duration 
1-50 minute class period 

 

Setting 
Classroom/computer 
lab 

Grouping 
Groups of 2-3 

PTI Inquiry Subskills 
1.3, 3.6, 3.7, 3.8, 4.2, 4.3, 5.2, 
5.3, 5.4, 7.2, 7.3 

 

Lesson Components 
Estimated 

Time 

Inquiry 
Subskills 

Used 

Technology 
Used 

Level of 
Student 

Engagement 
Brief Description 

Engage 
10 

minutes 
1.3  2 

Teacher reviews background 
information about sea surface 
temperature and students formulate 
hypotheses about the effects of water 
on temperature and fishing. 

Explore 
40 

minutes 
3.7, 3.8, 
4.2, 4.3 

Computer / 
Internet / 

Excel 
3 

Students use Internet to collect Gulf 
Stream sea surface temperature data 
throughout a particular year, look for 
patterns and analyze data by creating a 
SST chart in Excel. 

Explain 
20 

minutes 

3.6, 4.2, 
4.3, 5.2, 
5.3, 5.4, 
7.2, 7.3 

Computer / 
Internet / 

Excel 
3 

Students continue analyzing the data 
and answer questions regarding their 
findings. 

Expand 
20 

minutes 
5.2, 5.4, 

7.2 
Computer / 

Internet 
2 

Teacher shares online article and web 
video titled “What Causes the Gulf 
Stream?” to students and generates a 
class discussion on the effects of the 
Gulf Stream. 

Evaluate     
Students can be assessed by using the 
answers to the questions and the Excel 
charts. 

Level of Student Engagement 
1 Low Listen to lecture, observe the teacher, individual reading, teacher demonstration, teacher-centered instruction 

2 Moderate Raise questions, lecture with discussion, record data, make predictions, technology interaction with assistance 

3 High Hands-on activity or inquiry; critique others, draw conclusions, make connections, problem-solve, student-centered 
 

National Science Education Standards – Inquiry 

Use appropriate tools and techniques to gather, analyze and interpret data 
Develop descriptions, explanations, predictions, and models using evidence 
Think critically and logically to make the relationships between evidence and explanations 
Communicate scientific procedures and explanations 

National Science Education Standards – Earth Science 

Global patterns of atmospheric movement influence local weather.  Oceans have a major effect of climate, 
because water in the oceans holds a large amount of heat. 

Louisiana Grade Level Expectations – Inquiry 
Gr. 8, Inquiry GLE#7. Record observations using methods that complement investigations (e.g. journals, tables, charts) 
(SI-M-A3) 
Gr. 8, Inquiry GLE#9. Use computers and/or calculators to analyze and interpret quantitative data (SI-M-A3) 
Gr. 8, Inquiry GLE#11. Construct, use, and interpret appropriate graphical representations to collect, record, and report data 

(e.g., tables, charts, circle graphs, bar and line graphs, diagrams, scatter plots, symbols) (SI-M-A4) 
Gr. 8, Inquiry GLE#12. Use data and information gathered to develop an explanation of experimental results (SI-M-A4) 
Gr. 8, Inquiry GLE#13. Identify patterns in data to explain natural events (SI-M-A4) 
Gr. 8, Inquiry GLE#19. Communicate ideas in a variety of ways (e.g. symbols, illustrations, graphs, charts, spreadsheets, 

http://mynasadata.larc.nasa.gov/preview_lesson_nostds.php?&passid=13
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concept maps, oral and written reports, equations) 
Gr. 8, Inquiry GLE#22. Use evidence and observations to explain and communicate the results of investigations (SI-M-A7) 

Louisiana Grade Level Expectations Earth Science  
Gr. 8, GLE#23 – Explain the processes of evaporation, condensation, precipitation, infiltration, transpiration, and sublimation as 

they relate to the water cycle (ESS-M-A10) 
Gr. 8, GLE#24 – Investigate and explain how given factors affect the rate of water movement in the water cycle (e.g., climate, 

type of rock, ground cover) (ESS-M-A10) 

 
Materials List (per group 

 Computer with Internet access  
 Microsoft Excel (or other spreadsheet program) 

 
Advance Preparation 

1. Check to see that the browser being used is compatible with the NASA Live Access Server 
(http://mynasadata.larc.nasa.gov/las/servlets/dataset) and that pop-up blockers are turned off on the 
computer’s browsers. 

2. Assign students a particular year to explore (the Gulf Stream can meander with time). 

 

Other Information 
Learning Objectives 

 Students will be able to understand and explain the importance of the Gulf Stream  
 Students will be able to explore real satellite data and construct graphs for analysis 

 
Prior Knowledge Needed by the Students 

 Accessing websites on the Internet 

 Using Excel to create graphs 

 
Procedure 
 
Engage   

1. Review the following background information with the students: 
 
Intense incoming solar radiation of the Sun is continuously entering into the vast tropical oceans of the Earth. 
The energy enters these water bodies at the surface when absorbed radiation is converted into heat energy. 
The warmed surface water is then transferred downward by conduction and convection to form a mixed 
surface layer of increased temperature. The horizontal transfer (balance) of this heat energy from the Equator 
to the poles is accomplished by ocean currents.  
 
One of the most studied and important ocean currents of the world lies along the eastern coast of the United 
States and is called the Gulf Stream. It derives its name from its source region of warm water in the Gulf of 
Mexico. The Gulf Stream transports enormous amounts of heat from the Gulf of Mexico northward along the 
East Coast, and then northeastward toward Europe. Along the way, it warms the overlying atmosphere, 
transferring much of its heat energy through the process of evaporation. The latent heat energy (released as 
the warm air rises and condenses) can fuel interesting weather events such as East Coast snowstorms and 
hurricanes, and provide milder winters for the high latitudes of Europe.  
 
The evaporative process also causes the cooling surface waters arriving in the North Atlantic to become 
increasingly salty and dense enough to sink. The water then flows back southward toward the tropics along the 
bottom of the Atlantic Basin. This overturning is part of a global pattern of ocean circulation driven by winds 
and the exchange of heat and water vapor at the sea surface. It is believed that any small changes to this 
circulation will have significant effects on global climate. 
 
For the past two decades, scientists have been collecting sea surface temperature (SST) data from satellites, 
buoys and ships in the Gulf Stream and Atlantic Basin. In this lesson, you will gain access to the data used to 
monitor these weather and climate effects. The data are collected by a NOAA satellite instument called the 
Advanced Very High Resolution Radiometer (AVHRR) and are combined with other observations to create a 
product called the Multi-Channel Sea Surface Temperature (MCSST). 
 

2. As a class, have the students help formulate hypotheses about (1) the effects of the Gulf Stream on coastal 
water temperatures and (2) the effects of the gulf Stream on the fishing industry.  Write the hypothesis on the 
board and have them also write them on their Blackline Master 1 worksheet in the space provided. 

http://mynasadata.larc.nasa.gov/las/servlets/dataset
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Explore  

1. Have students work through the student procedure in the Blackline Master 1.  Make sure each computer is 

connected to the NASA Live Access Server (http://mynasadata.larc.nasa.gov/las15/servlets/dataset) and make 
sure that pop-up blockers are turned off.   

2. Assign each group a particular year to explore (1997-2008). 
 
Part I: Students will explore the NASA Live Access Server (LAS) and produce plots of sea surface 

temperature.  
 
Part II: Students will prepare a time series of data for a particular location on the Gulf Stream. 
 
Part III: Students will use Excel to produce and analyze graphs of sea surface temperature.    

 
Explain 

1. Have students work through the questions on their Blackline Master 1.   
2. Review the answers as a class and generate a class discussion on the students’ observations. 

 
Expand  

1. Read the article found at http://www.teachersdomain.org/resource/ess05.sci.ess.watcyc.gulfstream/ and 
discuss as a class.  You can also watch the short 2 minute video on “What Causes the Gulf Stream?” that is 
interesting and visually appealing to the students. 

2. It is claimed that the Gulf Stream brings mild winter climate to Eastern Europe. Discuss as a class if this is 
myth or fact, or simply an incomplete explanation. 

3. What effects will global warming have on the Gulf Stream? Discuss as a class the climate feedbacks described 
in the article. 

 
Evaluate 

1. Students can be assessed by using the answers to the questions in the Blackline Master 1 and the Excel 
charts. 

 
Blackline Master 

1. Sea Surface Temperature 
 
Supplementary Resources 
 
Credits 
Rex Roettger, Aguadilla, Puerto Rico 

http://mynasadata.larc.nasa.gov/las15/servlets/dataset
http://www.teachersdomain.org/resource/ess05.sci.ess.watcyc.gulfstream/
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Name:  ________________________________________________ Date:  ____________ 
 
 

Sea Surface Temperature 
 
Student Procedure: 
 
Hypothesis 1) What effect does the Gulf Stream have on coastal water temperatures?  __________________________ 
 
_______________________________________________________________________________________________ 
 
_______________________________________________________________________________________________ 
 
Hypothesis 2) What effect does the Gulf Stream have on the fishing industry?  ________________________________ 
 
_______________________________________________________________________________________________ 
 
_______________________________________________________________________________________________ 
 

 
Part I:  

1. Your computer should be connected to the NASA Live Access Server:  
http://mynasadata.larc.nasa.gov/las/servlets/dataset. 

2. From the home page, select the dataset “Oceans”, then click the check box next to Weekly Sea Surface 
Temperature (MCSST). Click the red Next link. 

3. Set the Select view drop-down menu to Longitude-Latitude map (xy). 
4. Select the region as “North America”. 
5. Then, enter the latitude and longitude coordinates of the Gulf Stream in the text boxes to the right of the map.  

Here are the coordinates you should enter:   Latitude range:   90 W – 60 W 
      Longitude range: 35 N – 15 N 

 
 

6. Make sure you click the “Go” button underneath the boxes containing the coordinates. 
7. Next to Select time, select January 6 and the year you wish to explore or enter the year that was assigned to 

you. For example, January 6, 2000. Click the red Next link. 
8. Your color plot should appear in a pop-up window.  
9. Save this data by clicking File  Save As.  Enter “Gulf Stream – January” as your file name and save it to your 

desktop or another specified location.  Close this pop-up window. 
10. Repeat steps 7-9 three times, choosing April 6 once, July 6 once, and October 6 once (and saving each file 

accordingly with the Month name) in order to explore seasonal changes in the Gulf Stream sea surface 
temperature. 

11. Using these 4 graphs, answer Question 1 on the Blackline Master page 3. 
 
Part II:  

1. After closing all graphs and pop-up windows, stay on the Weekly Sea Surface Temperature page that you 
were working from in Part 1. 

2. Under the dropdown menu for Select View, choose Time Series (t). 
3. Under the dropdown menu for Select Output, choose ASCII file. 

Blackline Master #1, pg. 1 

http://mynasadata.larc.nasa.gov/las/servlets/dataset
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4. Then, enter the latitude and longitude coordinates of the Gulf Stream in the text boxes to the right of the map.  
Here are the coordinates you should enter:   Latitude:   75 W 
      Longitude: 25 N 

 
 

5. Make sure you click the “Go” button underneath the boxes containing the coordinates. 
6. Next to Select time range, select January 1 – December 31 and the year you wish to explore or enter the year 

that was assigned to you. For example, January 1, 2000 – December 31, 2000. Click the red Next link. 
7. Click “Your ASCII file” link to see the table of values.  Your file should appear in a pop-up window containing 

the weekly SST data for the year you entered.    
8. Save this data by clicking File  Save As.  Enter “Gulf Stream SST” as your file name and save it to your 

desktop or another specified location.  Close this pop-up window. 
 
Part III:  

1. Open the data file(s) with Excel, or open Excel and import your table(s) of values. 
2. Open Microsoft Excel. Click on the Data menu at the top, then under the Get External Data section, click on 

Import Text File or From Text.  Choose your file and click Import to retrieve data.  Note:  These directions may 
vary based on the version of Excel you have. 

3. The Import Wizard opens. Choose delimited. For Start Import at row, enter 9.  Click Next. Choose Tab and 
Space as Delimiters.  Click to Finish and import data.  Note:  Again, these directions may vary based on the 
version of Excel you have. 

4. If column B is full of 0’s or some other number, highlight column B, right click, and select Delete to remove this 
column.  All you need is the two columns that contain the date and the sea surface temperature.   

5. To create a chart displaying this data, first highlight the data in columns A and B, then click on the Insert menu 
at the top.  Under the Chart section, select the 2-D Line graph. Note:  Again, these directions may vary based 
on the version of Excel you have. 

6. Your chart should appear.  You can format it by resizing it to make it bigger.  Delete the legend on the right of 
the graph if preferable.  You can also use the Layout menu at the top to enter a Chart Title (“SST for Gulf 
Stream Locations”) and to label the X and Y axes as “Date” and “Temperature (C)”.  Note:  Again, these 
directions may vary based on the version of Excel you have.  Here is an example of a completed SST Chart: 
 

 
 

Blackline Master #1, pg. 2 
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7. If possible, print out your data chart or save by clicking File  Save As.  Enter “Gulf Stream Chart as your file 
name and save it to your desktop or another specified location. 

8. Using your output from Parts 1-3, answer Questions 2-5 below with your group. 
 

 

Questions: 
 

1.  Using your four color plots from Part 1, find the minimum and maximum temperature in the Gulf Stream for each of 
the four months (January, April, July and October). Discuss with your group any major differences in temperature over 
the course of the year. Is the position of the Gulf Stream changing by season? 
 
________ _____________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 

2. Can you describe how the sea surface temperature of the Gulf Stream affects the weather along the East Coast?   

________ _____________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 

3. How do you think the position of the Gulf Stream may affect offshore operations such as the fishing industry? 

________ _____________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 

4. Based on your discoveries from the activity, do the results agree with your hypotheses? 

________ _____________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 
5. At latitude 45 N, winter temperatures of Bar Harbor, Maine can get as low as -15 C while at Newquay, United 
Kingdom it can get as low 41 C. Can you draw any conclusions about the difference in climate between western and 
eastern shores of the North Atlantic Basin? 

 
________ _____________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 

 _____________________________________________________________________________________________ 

 

Blackline Master #1, pg. 3 


